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By installing this software you agree to the following
provisions. If you do not agree with these provisions, return
the software and all materials included with the software
within thirty (30) days.

This is a license agreement and not an agreement for sale,
Alliance Laundry Systems LLC (hereinafter “Alliance Laundry
Systems”) hereby licenses this software to you under the
following terms and conditions.

This agreement supersedes all prior agreements, proposals, and
representations between you and Alliance Laundry Systems
regarding all Alliance Laundry Systems Software products.

Customer agrees that aspects of the licensed materials,
including the specific design and structure of individual
programs, constitute trade secrets and/or copyrighted material
of Alliance Laundry Systems. Customer agrees not to disclose,
provide, or otherwise make available such trade secrets or
copyrighted material in any form to any third party without the
prior written consent of Alliance Laundry Systems. Customer
agrees to implement reasonable security measures to protect
such trade secreets and copyrighted material. Title to Software
and documentation shall remain solely with Alliance Laundry
Systems.

STANDARD USE LICENSE

YOU MAY:

@ Use this software on any compatible computer, provided the
computer is owned by you the licensee. This includes
computers located in branch offices that support and
manage laundry equipment.

YOU SHALL NOT:

® Use, copy, or transfer copies of this software except as
provided in the License Agreement.

@ Alter, merge, modify or adapt this software in any way,
including disassembling or decompiling or reverse
engineering.

® Loan, rent, lease, or sublicense this software or any copy.

This license is effective until terminated. It may be terminated
by you by destroying the software media and all copies. It will
terminate automatically if you fail to comply with any of the
terms of this License Agreement, and on any such termination
you will destroy the software media and any back-up copies.

Alliance Laundry Systems retains all rights not expressly
granted. Nothing in this License Agreement constitutes a
waiver of Alliance Laundry Systems' rights under the U.S.
Copyright laws or any other federal or state law.

LIMITED WARRANTY

Alliance Laundry Systems warrants that the software will
substantially conform to published specifications and to the
documentation, provided that it is used on the computer
hardware and with the operating system for which it was
designed. Alliance Laundry Systems also warrants that the
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documentation are free from defects in materials and
workmanship. Alliance Laundry Systems will replace defective
media or documentation or correct substantial software errors at
no charge, provided you return the item to Alliance Laundry
Systems within 90 days of the date of delivery. If Alliance
Laundry Systems is unable to replace defective media or
documentation or correct substantial software errors, Alliance
Laundry Systems will refund the license fee. These are your
sole remedies to any breach of warranty. Except as specifically
provided above, Alliance Laundry Systems makes no
warranty or representation, either expressed or implied,
with respect to this software or documentation, including
their quality, performance, merchantability, or fitness for a
particular purpose.

Because software is inherently complex and may not be
completely free of errors, you are advised to verify your work.
In no event will Alliance Laundry Systems be liable for
direct, indirect, special, incidental, or consequential
damages arising out of the use or inability to use the
software or documentation license.

The warranty and remedies set forth above are exclusive
and in lieu of all others, oral or written, express or implied.
No Alliance Laundry Systems dealer, distributor, agent or
employee is authorized to make any modification or addition to
this warranty.

Some states do not allow the exclusion or limitation of implied
warranties or limitation of liability for incidental or
consequential damages, so the above limitations or exclusions
may not apply to you.

U.S. GOVERNMENT RESTRICTED
RIGHTS

The software and documentation included are provided with
RESTRICTED AND LIMITED RIGHTS. Use, duplication, or
disclosure by the Government is subject to restrictions as set off
in FAR § 52.277-14 (June 1987) Alternate I1I(g)(3)(June 1987),
FAR § 52.277-19 (June 1987), or DFARS § 52.277-
7013(c)(1)(ii)(June 1988), as applicable, Contractor/
Manufacturer is Alliance Laundry Systems LLC, Shepard
Street, Ripon, WI 54971.

GENERAL

Should you have any questions concerning this License, write
to Software License Agreement, Alliance Laundry Systems
LLC, Shepard Street, Ripon, WI 54971.
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System Requirements

System Requirements (PC)

The PC Application has the following minimum recommended PC requirements:
* Keyboard and mouse
*  Microsoft Windows XP with Service Pack 2
* 1 GHz processor
* 512 MbRAM
*  XGA (1024x768)
* CDorDVD Drive

System requirements (PDA)

The PDA software requires 5 MB of available storage space, depending on the processor and components
installed on the PDA.

Operating systems that support the PDA software include the following:

* Microsoft Windows Mobile 2003 or greater
* Infrared communication window (IrDA) or standard SD expansion slot

12-08-278 © Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT 5



PC Application Installation

NOTE : If using the Microsoft Windows 7 or Vista operating system, you must disable User
Access Control (UAC) before the software is installed.

Disabling User Access Control (UAC) - Windows 7 Operating System Only

Nk W=

Open the control panel.

Click the User Accounts and Family Safety heading.

Click the User Accounts heading.

Click Change User Account Control settings.

Use the sliding bar tool to drag the icon to Never notify and click OK.

In the User Account Control dialog box, click Yes.

You will be prompted to restart your computer to apply the change. Do so when you are ready.

Disabling User Access Control (UAC) — Microsoft Vista Operating System Only

b S

9]

Open the Control Panel.

Under the User Accounts and Family Safety heading, click Add or remove user accounts.
Click one of the accounts.

On the account screen, under the Additional things you can do heading, click Go to the main
User Accounts page.

Under the Make changes to your user account heading, click Change security settings.

In the Turn on User Account Control (UAC) to make your computer more secure section, click the
Use User Account Control (UAC) to help protect your computer checkbox to deselect it.
Click OK.

You will be prompted to restart your computer to apply the change. Do so when you are ready.

Installation

NOTE: You must have administrator rights to install the PC application

1.
2.

9]

Insert the software CD-ROM into your PC’s CD/DVD drive.

If the installer does NOT automatically start...

a. Navigate to the CD drive using “Windows Explorer” or “My Computer”.

b. Double-click the Setup.exe file on the CD.

You may be prompted to install additional components onto your PC before the PC Application
can be installed (e.g., Crystal Reports for .NET Framework 2.0, Visual C++ Runtime Libraries
[x86], .Net Framework 2.0). If you are prompted, review the component’s licensing agreement
and then click the Accept or Install button.

After the additional components are installed, the installer will start automatically.

Follow the on-screen instructions to install the PC Application.

After the software has been installed, click the Close button. A shortcut for the program is added
to the PC’s desktop and Start menu.
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PC Application Installation (continued)

Updating the PC Application

1.

2.

If using a PDA, transfer all data from the PDA to the PC by using the Receive... button in the PC

application.

Make a back-up of the database. Under the PC’s Start menu, under A/l Programs, locate the

Electronic Control Software menu and click Database Backup.

Uninstall the previous version of the Electronic Control Software.

a. From the PC’s Control Panel, open the Add or Remove Programs utility.

b. From the list of currently installed programs, select the Electronic Control Software program
and click Remove.

Insert the CD with the new version of the Electronic Control Software into the PC and follow the

on-screen instructions.

Locate and double-click the Electronic Control Software shortcut on the PC’s desktop. If a

database update is required, the Database Setup utility will open. To update the database, click the

Update button.

The new version of the Electronic Control Software will install.

Opening the PC Application

Double-click the application’s shortcut on your PC’s desktop or, under your PC’s start menu, click All
Programs. Locate and click the software.

NOTE: The first time the PC Application is opened, you will be prompted to enter your
Software Security Code and/or install the database server. Follow the on-screen instructions.

Understanding the My Machines Structure

1. The first time the application is open, the default My Machines structure is shown (i.e., My
Branch and My Location) in the tree view.
Definition:
* Branch: This is a group of locations (e.g., Campus Laundries).PC Application
* Location: This is the actual physical location of a laundry facility
(e.g. North Campus).
12-08-278 © Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT 7



PC Application Installation (continued)

Adding a Branch or Location

1. To add a Branch or Location to the My Machines structure, in the My Machines structure, select
the level above which you would like to add an item and click the New... button.

Software E]@
File Edit Infrared Reports Tools Help
(i N e E_'Eanch..‘ L3 25 | ] (=) Frint...
fa
- My Machines 0 branches
= My P it
AL Mame | Locations Machines | Modified | Created
PHM1472R

Figure 1

Example: To add another Location to the My Machines structure,

a. In the My Machines structure, click My Branch (i.c., the level above My Location).

b. Click the New location... button.
2. The New location window opens.

New location E]@
Mame : My Location Branch : (&) My Branch -
Information
Contact
First name : Last name :
Title @ E-rnail !
Phone : Fax :
Address
Address :
City
State/Province ! Postal code !
Other information
Account # : Target hours ; 405 /week
Motes
PHM1473R
Figure 2
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PC Application Installation (continued)

3. Enter information into the New... window and click the OK button.

Example (Location): When adding a new Location, this window can be used to change the
Location’s Branch and to add information about the Location (e.g., the Location’s name, contact
information, address and notes).

Example (Branch): If adding a new Branch, in the New branch window, the only information that
can be added is the Branch’s name and notes.
4. The new element is added to the My Machines structure.

Editing a Branch or Location

1. To edit a Branch or Location, in the My Machines structure, right-click the branch or location you
would like to edit.

Example: To edit information about My Location, under My Branch, right-click My Location.
2. From the pop-up menu, click Edit Location... or Edit Branch....

Software Q@

File Edit Infrared Reports Tools  Help
{2 New Location.., | 3 25 | (= Print...

[ My Machines \:.) My Branch 1 location {1 selected)
=@ My Branch

MName Machines | Address | City  State  Zip | Modified | Created

! My Locatinn n - 12/5/2011 11:54:54 AM
4] My Presets Explore Location

{2 My Location

Edit Loeation... I
Batch Rename Machiifes ..

Cut

Delete

X &

PHM1474R

Figure 3
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PC Application Installation (continued)

3. The...information for :...window opens.

Branch information for : My Branch g@
Name : ‘My Branch
Motes
PHM1475R
Figure 4

4. Edit the information for the item as needed and click the OK button.

Example (Location): For Locations, the Branch assignment, name, contact information, address and
notes can be edited.

Location information for : My Location E]@

Name : My Location Branch : (&) My Branch ~

Infarmnation P

[ add Picture. ..

PHM1476R

Figure 5

Example (Branch): For Branches, the name and notes can be edited.
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PC Application (continued)

Manual Machine Entry (Coin Software Only)

Manual machine entry provides a way to add machines to the tree view manually, without the use of a
network or PDA.

12-08-278

Manually Entering a Machine

b=

o N wn

In the tree view, click the location into which you would like to manually enter a machine.
Click New Manual Entry Machine. The New manual entry machine window opens.

In the Name: textbox, enter the name of the machine.

In the Machine information section, enter the machine’s serial number, model and machine
type. Also specify if you would like the machine to use cumulative processing or not.

In the Prices section, set the cycle, coin and start pulse values.

In the Counters section, enter information into the necessary textboxes.

Click the OK button.

The machine is added under the location that was selected in the tree view.

Adding a Manual Entry Collection

1. In the tree view, click the location that contains the manual entry machine into which you
would like to add a manual entry collection.

2. In the location window, right-click the desired machine.

3. From the pop-up window, click Add Manual Entry Collection.... The Add new manual entry
collection window opens.

4. In the Counters section, enter information into the necessary textboxes.

Click the OK button.

© Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT 11



PC Application (continued)

My Presets

Adding a Preset

1. In the tree view, click My Presets.
2. Under the New Preset information menu, select the type of preset.

NOTE: The list of presets will vary depending on your version of the software.

Software E]@
File Edit Infrared Reports Tools Help
& New Preset @ L] (= Print...
Washer Extractor Preset... ets 0 presets
Tumbler Preset... eneration | Machine type | Modified | Created
PHM1477R
Figure 6

The New... preset window opens.

3. In the Name: textbox, enter the name of the Preset.
4. Click the OK button.
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PC Application (continued)

Editing a Preset

1. In the tree view structure, click My Presets.
2. From the list of presets, right-click the preset to be edited. From the pop-up menu, click Edit
Preset.... The Edit...preset “...” window opens.

Software E]@
File Edit Infrared Reports Tools Help
LehNew Preset ~ | 3 2 | (=) Print...
My Machines “I My Presets 1 preset (1 selected)
= ) My Branch
. /y Name Generation Machine type Modified Created
{2 My Location Frontload Washer
“! My Presets
My Pracet — 12/5/2011 11:59:38 AM  12/5/2011 11:59:38 AM
dit Preset...
[} Export Preset...
Copy
% Delete
PHM1478R
Figure 7

3. Edit the preset.
NOTE: The editable items under each programming tab vary by type of preset.

4. To close the Edit...preset “...” window, click the OK button (to save the changes) or the Cancel
button.

My PDAs

My PDAs provides a detailed list of the PDAs that have communicated with the PC. This list includes
PDA serial numbers as well as information about the last user of the PDA and shows when the
information from the PDA was last downloaded to the PC.

Viewing My PDAs

1. Under the Tools menu, click Options.... The Options window opens.
2. Under the Application settings heading, click the Enable PDA tracking checkbox.
3. To close the Options window, click OK. My PDAs is displayed in the tree view.

12-08-278 © Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT 13



PC Application (continued)

My User-Defined Types

14

NOTE: If option does not appear on your list, go to tools > Options and place a check mark in
the box for that option. Select OK to save.

My User-Defined Types can be used to add additional Machine Types.

Adding Machine Types

1. To add an additional machine type, in the tree view, under My User-Defined Types, click the item
you would like to add.

2. Click New ... Type. A New ... Type window opens.

3. Fill in the desired information.

4.

Click the OK button to close the window and save the changes or the Cancel button to close the

window without saving the changes.

© Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT
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PC Application (continued)

Editing Machine Types

1.

nali

To edit a machine type, in the tree view, under My User-Defined Types, click the item you would
like to edit.

In the ... Types window, right-click the user-defined type you would like to edit. A pop-up window
opens.

Click Edit ... Type.... The Edit ... type “...” window opens.

Edit the information as needed.

Click the OK button to close the window and save the changes or the Cancel button to close the
window without saving the changes.

Assigning a User-Defined Type to a Machine

1.
2.
3.
4.

12-08-278

In the tree view, click the location that contains the desired machine.

In the location window, right-click the desired machine.

From the pop-up menu, mouse-over User-defined type.

From the sub pop-up menu, click the user-defined type you would like to assign to the machine.
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PC Application (continued)

Infrared Communication

NOTE: If option does not appear on your list, go to tools > Options and place a check mark in
the box for that option. Select OK to save.

To communicate between the PC and the machine’s control make sure the USB device is connected
to the PC and select an option from the Infrared menu.

Collect Machine Data...

Collect data from the machine.

After communicating with a new machine for the first time, the machine is added to “Unknown
Location.” The machine must then be placed into the correct location.

Collect Machine Programming...

Collect programming information from the machine.

Program Machine...

Download, edit and upload presets to the machine.

Rapid Advance...

Rapid advance to a step within a cycle.

Start Machine (Rapid Advance)...*

Rapid advance to the beginning of a cycle.

Stop Machine (Rapid Advance)...*

Rapid advance to the end of a cycle.

Clear Partial Vend...*

If a partial vend has been entered, clear it from the control.

Pause Washer-Extractor Cycle*

Pause a cycle in progress.

Change Machine Serial Number...

Change the machine serial number stored on the machine’s control.

Change Machine Model Number...

Change the model number stored on the machine’s control.

*Only applicable to Coin Software.
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PC Application (continued)

Manual Programming

Enable or disable manual programming of the machine’s control.

Security Code

Enable or disable the security code on the machine.

Synchronize Machine Clock

Change the machine’s date and time to match the PC’s date and time.

NOTE: Machine’s factory default time is set to Central Standard Time.

Reset to Factory Defaults

Reset the machine’s control to the factory defaults.

Run Production Test

View information about the machine’s control and test some of the machine’s components.

Water Leak Detection Test*

Test for a water leak in the machine’s drain.

Tools

Items under the Tools menu include the following:

Export...

Save branches, locations, machine data and presets as a transfer file (.ctf).

NOTE: Presets can be exported individually by right-clicking one or more presets and selecting
Export Preset.

Import...

Load branches, locations, machine data and presets from a transfer file (.ctf).

Options...

Change the PC software’s settings, including application, including database, reports and infrared
communication.

*Only applicable for Washer-Extractor.
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PC Application (continued)

Receiving Information from the PDA

NOTE: Before installing the Software onto a PDA, make sure that the PDA’s ActiveSync
software has been installed onto the PC and that the PDA is connected to the PC.

1. Make sure the PDA is connected to the PC.
2. Under the PDA menu, click Receive data from PDA....

3. Information is sent from the PDA to the PC and is displayed in the My Machines structure.

Sending Information to the PDA

NOTE: Before installing the Software onto a PDA, make sure that the PDA’s ActiveSync
software has been installed onto the PC and that the PDA is connected to the PC.

1. Make sure the PDA is connected to the PC.

2. Under the PDA menu, click Send data to PDA....
3. Choose the information to send to the PDA.

4. Information is sent from the PC to the PDA.

Reports Menu

The Reports Menu contains 5 report groups, which are as follows:

General Reports
Includes reports related to machine listing, security, location and presets.
* Machine Listing for “My Machines”
*  Machine Setup for “My Machines”
* Location Listings for “My Machines”
* Preset Listing
* Machine Type Listing

18 © Copyright, Alliance Laundry Systems LLC — DO NOT COPY or TRANSMIT
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PC Application (continued)

Audit Reports
Includes reports detailing the operation, productivity, vending and security of the item highlighted
in the tree view.

NOTE: Some reports are only available in the Coin Software.

* Audit Operation for “My Machines”

* Audit Productivity for “My Machines”

* Audit Common Diagnostic for “My Machines”
* Audit Error Diagnostic for “My Machines”

* Audit Total Vending for “My Machines”

* Audit Detailed Vending for “My Machines”

* Audit Additional Vending for “My Machines”
* Audit Turns for “My Machines”

* Audit Special Vend for “My Machines”

* Audit Security for “My Machines”

Lifetime Reports
Offers reports summarizing the operation and error diagnostics over the lifetime of the item
highlighted in the tree view.

* Lifetime Operation for “My Machines”

* Lifetime Error Diagnostic for “My Machines”

Pricing Reports*

Displays the pricing information for every cycle on every machine.
* Pricing Detailed for “My Machines”
* Pricing Overview for “My Machines”
* Pricing Change for “My Machines”

Water Usage Reports

Lists the approximate amount of water each machine uses per cycle.
*  Water Usage Detailed for “My Machines”
*  Water Usage Overview for “My Machines”

Help Menu
The Help Menu includes the following:

User Instructions...
User Instructions... is a link to a PDF of these user instructions

About...
Click to open a window that shows the software’s version number.

*Only applicable to Coin Software.
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PC Application (continued)

Start Menu Applications

Elements of the PC application software (e.g., database setup, database backup and the user
instructions) can be accessed through the PC’s Start menu.

* Database Setup: Create or update a database by entering the server and database name.
* Database Backup: Allows the database to be backed up or restored.
e User Instructions: Provides a PDF of these user instructions.
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PDA Application Installation

Windows 7 Operating Systems Only: Using Sync Center

NOTE: Before installing the Software onto a PDA, make sure that a new sync partnership is set
up in Sync Center.

Turn on PDA and plug into PC.

Click the Start button > All Programs > Accessories > Sync Center.
On the left menu, select Set Up new sync partnerships.

Select the name of PDA in list of available sync partnerships.

On toolbar, click Set Up.

Select Sync settings and schedule.

Select your device from list of sync partnerships.

Select Sync.

NOTE: Before installing the Software onto a PDA, make sure that the PDA’s ActiveSync
software has been installed onto the PC and that the PDA is connected to the PC.

Windows XP and Vista Operating Systems Only ActiveSync Installation

1. Insert the CD supplied with your PDA into your computer’s CD-ROM drive and follow the on-
screen instructions.

2. Ifa CD wasn’t supplied with your PDA, navigate to the ActiveSync4.5 folder on the computer
software CD, double-click the ActiveSync4.5setup.msi file and follow the on-screen
instructions.

3. As an alternative, navigate to the following web page, connect your PDA to your computer and
follow the on-screen instructions:
http://www.microsoft.com/windowsmobile/en-us/help/synchronize/activesync-download.mspx

Installing the PDA Application

1. Open the PC Application by double-clicking the icon on your PC’s desktop or by selecting the
program from your PC’s Start menu.

2. Under the PDA menu, click Install PDA Application.

3. Follow the on-screen instructions to install the PDA Application.

NN R WD =

NOTE: If PDA menu is not present, select Tools/Options on Application Tab and check Show
PDA Menu Items.

Updating the PDA Application

1. Update the PC Application as explained in the Updating the PC Application section.
2. Start the PC Software by double-clicking the shortcut on the PC’s desktop.

3. Under the PDA menu, click Install PDA Application....

Skip steps 1 through 3

Complete Step 4: Install Software Application

Complete Step 5: Transfer Software Key

Complete Step 6. Transfer Application Data to PDA
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PDA Application

Opening the PDA Application

1.

From the Start menu, press Programs.

2. From the Programs screen, select the program.

Collecting Information from the Machine with the PDA

22

1.
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From the home screen, press Collect. The Collection Options screen appears.

Press Collect Machine Audit. The Collect Machine screen appears.

Aim the PDA at the infrared communication window on the machine’s control. Press OK. The
machine’s data is uploaded from the machine’s control to the PDA. The My Machine screen is
displayed if the machine has not been placed into a valid location.

Assigning New Machines to a Location

1. The new machine will appear in Unknown Location.

2. Create a new location if needed or use an existing location. Refer to Adding a Branch or Location
in the PC Application section.

3. Press and hold the machine’s serial number on the screen. A pop-up window will appear.

4. Select Cut and then press and hold the new location.

5. Select Paste to put it into the new location.

6. Close My Machines window.

7. Continue collecting from other machines. All the machines that are collected that don’t have a
location will be automatically moved to this new location.

8. To exit the auto location function, close the collection window.

Viewing My Machines

1. From the home screen, press Collect. The Collection Options screen appears.

2. Press My Machines. The My Machine screen appears. Refer to the Understanding the My

Machines Structure section in this guide.

NOTE: Press and hold down on a machine until menu appears. Press View Audit to see audit
data from the last collection, if available.

3. Press the Close button.
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PDA Application (Continued)

Saving a Machine’s Programming

1.
2.
3.

From the home screen, press Collect. The Collection Options screen appears.
Press Save Machine Programming. The Communications screen appears.
Aim the PDA at the infrared communication window on the machine’s control. Press OK. The

machine’s data is uploaded from the machine’s control to the PDA. The Collection Options screen

is displayed.

Manually Entering a Machine’s Audit Data

1.
2.
3.

4,

5.

From the home screen, press Collect. The Collection Options screen appears.

Press Manual Entry. The Select Machine screen appears.

To add the programming for a new machine, press the New Machine button. The Machine
Information screen appears.

Enter the machine’s serial number, model number and select it’s machine type. Press the

Counters tab to manually enter the machine’s counters or the Prices tab to change the machine’s

vend, coin or start pulse values.
To save the machine information, press Save. The Collection Options screen appears.

NOTE: The total counter values can only be viewed by sending the data to the PC.

Programming the Machine

1.
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From the home screen, press Program. The Programming Options screen appears.

Loading Machine Cycles

1. To upload and edit cycles from the machine, from the Programming Options menu,
press Load From Machine. The Communications screen appears.

2. Aim the PDA at the infrared communication window on the machine’s control.
Press OK. The Programming Options screen appears with a note at the bottom that
states “... Programming Loaded”.

Loading Preset Cycles

1. To load preset cycles, from the Programming Options menu, press Load From
Presets.

2. Select the type of preset to be loaded. Press OK.

Creating a New Preset

1. To create a new preset, from the File menu, press New Preset.

2. To edit or save the preset, press Edit Machine Programming (see the Editing
Cycles section).

3. To save the new preset to the database, under the File menu, press Save.
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PDA Application (Continued)

Editing Cycles

1. To edit the cycles, from the Programming Options menu, press Edit Machine Programming.
The Programming screen appears.

2. From the Programming screen, press Cycles. The Edit Cycles screen is displayed. Some models
list cycles as soon as Edit Machine Programming is selected. Press cycle that needs to be updated.

3. From the cycle type drop-down lists, select the cycle type to be edited. Press and hold down on
cycle display’s menu to show water usage data or to copy cycle. Cycle can then be pasted to any
other cycle.

4. From the stage drop-down list, select the stage to be edited.

5. Edit the cycle’s stage.

NOTE: The available programming tabs will vary by machine type.

6. To exit to Edit Cycles screen, press Save.

Editing Pricing (Only Available For Vended Products)

1. To edit the cycle’s pricing, from the Programming Options menu, press Edit Machine
Programming. The Programing screen appears.

2. From the Programming screen, press Pricing. The Pricing screen is displayed.

3. Edit the pricing information.

NOTE: The available pricing tabs will vary by machine type.
4. To exit to Pricing screen, press SAVE.

Editing Globals

1. To edit the global settings, from the Programming Options menu, press Edit Machine
Programming. The Programing screen appears.

2. From the Programming screen, press Globals. The Global Settings screen is displayed.

3. Edit the global settings.

NOTE: The available tabs will vary by machine type.
4. To exit to Global Settings screen, press SAVE.

Downloading to Machine

1. To download edited cycles from the PDA to the machine, from the Programming Options menu,
press Download to Machine. The Communications screen appears.

2. Aim the PDA at the infrared communication window on the machine’s control. Press OK.
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PDA Application (Continued)

Viewing Audit Data

1.
2.
3.

From the home screen, press Machine Details. The Machine Details screen appears

From the Machine Details menu, press View Audit Data. The Communications screen appears.
Aim the PDA at the infrared communication window on the machine’s control. Press OK. The
View Machine Data screen is displayed.

Audit Data

Press the Select Audit Data tab. From the Select Audit Data drop-down list, select a report.
For example, to view the Cycle Related Audit report, from the Select Audit Data drop-down list,
select Cycle Related Audit. The Cycle Related Audit report is displayed.

Machine Info.

Press the Machine Info. tab. The machine’s model number, serial number, installation date,
control serial number, control version number, output board number, node number and trim value
are displayed.

Mach Config Tab

Press the Mach Config tab. The machine’s control configuration information is displayed.

To save the machine’s data into a text file, press Create File. The file is stored in My
Documents\... Files.

Viewing Machine Configuration

1.

2.

3.

From the Machine Details menu, press View Machine Config. The Communications screen
appears.

Aim the PDA at the infrared communication window on the machine’s control. Press OK. The
View Machine Data screen is displayed with the Mach Config tab selected. The machine’s control
configuration information is displayed.

To save the control configuration information into a text file, press Create File.

Viewing Machine Status

1.

2.
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From the Machine Details menu, press View Machine Status. The Communications screen
appears.

Aim the PDA at the infrared communication window on the machine’s control. Press OK. The
View Machine Data screen is displayed with the Mach Status tab selected. The status of the cycle
in process on the machine is displayed.

To save the control status information into a text file, press Create File.
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PDA Application (Continued)

Maintenance

1. From the home screen, press Maintenance. The Maintenance screen appears.
2. From the Maintenance Options menu, select an item. The menu includes items related to machine
setup and troubleshooting.

Setup Configuration

1. From the home screen, press Help. The Help menu appears.
2. Press Setup Config. The Configuration Setup screen appears.
a. To change how the PDA uses the infared port, from the Comm Port drop-down list, select a
different port OR press Scan for Port to have the PDA select a port.
b. To change speed at which the PDA communicates with the control, from the Baud Rate drop-
down list, select a different option.
c. To save the configuration setup changes, press Save.
d. Press the Misc. tab to deselect “Show Unknown Location Machines” or “Enforce Strict
Programming Rules”.
3. To view information about the last import or to manually import data from another device, press
Import Log.
4. To view information about the last export or to manually export data to another device or for
emailing, press Export Log.
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Technical Support

If service is required, contact the nearest Authorized Service Center. To find the nearest service center,
visit us online at www.comlaundry.com.

If you are unable to locate an authorized service center contact:

Alliance Laundry Systems LLC
Shepard Street

P.O. Box 990

Ripon, Wisconsin 54971-0990
www.comlaundry.com

Phone: (920) 748-3121

Please have the following information available when you call.
Date Purchased

Software Name
Software Version

PC Operating System

PDA Operating System
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